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2. Features

TR-102 is a personal remote positioning device with built-in GPS and GSM modules; it’s compact and portable. Not only can 
TR-102 transmit the longitude and latitude coordinate to your cell phone by the short message service, but it can also transmit 
the longitude and latitude coordinate to your personal computer by the internet connection of GPRS and then displaying the 
location by a speciýc map software. There are three speed-dial keys and one emergency key on the TR-102. You can use 
these features for protecting and searching children and old persons. Further, you can use it as a security purpose and other 
purpose which needs remote positioning. 

1. Introduction

1. GPS/GPRS personal locator. 
2. GSM/SMS/GPRS communication. 
3. Omni-directional high sensitivity GPS antenna which can receive GPS signal from all direction. 
4. New technology and latest GPS SiRF-Star III chipset! Excellent for ýxing the position even at a weak signal status. 
5. Remote command control via mobile phones or through online software. 
6. Receive phone calls to have two way communications. 
7. Monitors can track the person without interfering him, LIVE! Real-Time tracking!
8. Locate the locator holder by just pressing a button on PC software or through mobile phone via SMS (short messaging 

system). 
9. Three quick dialing buttons for 3 preset phone numbers. 
10. Works worldwide! Support 4-frequency GSM 850/900/1800/1900 MHZ and GPRS class 12. 
11. SOS button send out exact location for immediate rescue/action. 
12. Independent SOS (emergency) button which will send GPS location information via SMS for up to 3 preset numbers (it 

can be 3 sets of different numbers than the 3 sets of quick dialing numbers). 
13. Device can be connecting to PC by using a USB cable for setup the arguments (package comes with mini USB cable 

when you purchase the device). 
14. Report device holder’s position at a preset time interval. 
15. Low battery notiýcation before the battery dies out! Worrying free on why the locator wouldnôt respond for this kind of 

situation! 
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Software Feature 
Professional Call Center program, supporting the operating system such as Windows 98 /2000 /XP, also supporting up to 5 
sets of TR-102's tracking function at the same time by using the GPRS mode. Clicking on one of the TR-102's user name from 
the Call Center program will open a browser with the latitude and longitude information displaying as a point at the center of 
the maps.google.com. The display map is Google's patented right.

3. Speciýcation

GSM module: embedded GSM 850/900/1800/1900 MHz , GPRS class 12

GPS Chipset: SiRF Star III

Frequency: L1, 1575.42 MHz
C/A code: 1.023 MHz chip rate
Channels: 20 channel all-in-view tracking
Antenna Type: Omni-directional GPS antenna
Position Accuracy: 10 meters, 2D RMS

Velocity Accuracy: 0.1 m/s
Time Accuracy: 1 us synchronized to GPS time
Default datum: WGS-84
Reacquisition: 0.1 sec., average
Hot start: 1 sec., average
Warm start: 38 sec., average

Hardware
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Cold start: 42 sec., average
Altitude Limit: 18,000 meters (60,000 feet) max.
Velocity Limit: 515 meters/second (1000 knots) max.
Acceleration Limit: Less than 4g
Jerk Limit: 20 m/sec3
Operating temperature: -20Á to 55Á C
Humidity: 5% to 95% Non-condensing
Dimension: 115 mm × 45 mm × 22.5 mm
Voltage: Rechargeable and replaceable 1300 mAh battery (3.7V), 5V for charging input.
Charging connector: DC 5V
Standby time: Over 100 hours
Talking time: 5 ~ 6 hours
LED: 3 LEDs showing Power, GPS and GSM status.
Key: 7 Keys for Power On/Off key, Emergency key, Intimate call * 3, Lock key and Answer/

Reject key.
USB port: Mini USB port for connecting to PC.
SAR: GSM850 Head: 0.758 

PCS1900 Head: 0.735 
GSM850 Body(GSM): 0.206 
PCS1900 Body(GSM): 0.177 
GSM850 Body(GPRS): 0.21 
PCS1900 Body(GPRS): 0.223 
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4. Start-up

4.1 Accessories
1. TR-102

2. 1300 mAh Li-ion Battery

3. Mini USB cable

4. AC power adapter

5. CD-ROM

6. Leather case (Optional)

1 2 3

4 5 6

Li-lon Battery
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4.2 Charging the battery
Before you can use the TR-102, you must complete the following procedures:

1. Fully charge the battery.  Before your ýrst time using of TR-102, please connect it with AC power adapter for battery charging at least 

10 hours under the power-off condition. (The included battery is specially designed for TR-102. Please do not use other type of battery, 

otherwise it will damage the device. If you need to change the battery for TR-102, please contact you local dealer.)

2. Install the SIM card. Please see the steps below in this page.

3. Complete the software setup. Please refer to chapter 6 for details.

Install SIM card:

1. Press on the battery cover, then pull it downward to open it. 

2. Remove the battery. 

3. Insert the SIM card into the cartridge according to the direction shown, and close the cartridge when done.

4. Put back the battery, and close the battery cover.

4.3 Install SIM card 
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5.1 Appearance

5. Hardware Overview

D
C

Answer / Hang up 

Quick dial 1 / Volume up

Quick dial 2 / Mute the microphone

Quick dial 3 / Volume down

SOS button

Power button

Power LED
GPS LED
GSM LED

Speaker

Microphone

Power adapter jack

Mini USB connector

Button Lock
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Power button Turn on / Turn off: Please see 7.1 for details.

SOS button You can assign up to 3 sets of phone numbers to the SOS button. When this button is pressed, TR-102 will send 
it's location information to these 3 sets of phone numbers by SMS.
TR-102 will ýrst call the SOS number 1 and send the location information by SMS.  Following, TR-102 will repeat 
the same procedure to SOS number 2 and 3.

Answer / Hang up When there is a incoming call, press this button to answer the incoming call. While in talking, press it will hang up 
the phone.

Quick dial 1 / Volume up You can set a phone number for this button; when this button is pressed, TR-102 will dial the preset number. 
While in talking, you can press this button to increase the volume.

Quick dial 2 / Mute the 
microphone

You can set a phone number for this button; when this button is pressed, TR-102 will dial the preset number. 
While in talking, the other party will not hear from you if this button is pressed to mute the microphone; press it 
again to enable the microphone. 

Quick dial 3 / Volume 
down

You can set a phone number for this button; when this button is pressed, TR-102 will dial the preset number. 
While in talking, you can press this button to decrease the volume.

GSM LED LED is on: TR-102 is turned on, but not connected to GSM network yet.
Blinking quickly (once per second): TR-102 is in dialing or talking mode.
Blinking slowly (once per 3 seconds): TR-102 is in the standby mode.

GPS LED The LED will be blinking when TR-102 is ýxing its location. More details please see Page 21 for SOS button and  
Page 27 for GPRS mode.

Power LED The LED will be orange when AC adapter is plugged for charging the battery. If the battery power is low, this LED 
will be on in red.

Power adapter jack Plug in the Power adapter to TR-102's power adapter jack for battery charging.

Mini USB connector Connecting TR-102 to PC by a Mini USB cable, you can setup all its features and functions from an application 
software in PC.

Button Lock Switch to lock all the buttons for the purpose of preventing buttons from been accidentally touched. (Only the 
power button is not lockable. When Button Lock is on, the LED indicators will þash 3 times if any other button is 
pressed.) 

5.2 Button description
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6. TR-102 Setup and Call Center Operation

1. Insert the CD into CD-ROM drive. When the autorun dialog box is displayed, 

click on "Install USB Driver" button to install the TR-102 driver. 

2. You will see dialog box 1, click on Next to continue.

3. When installation is complete, click on Finish to close the dialog box 2.

4. Reboot your PC to activate the USB driver.

6.1 Install the USB driver

Dialog box 1

Dialog box 2Autorun Dialog box
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6.2 Install the Call Center program

1. From the autorun dialog box, click on the "Install PC Software" to install the 

Call Center program. 

2. Follow instruction of dialog box 1 to continue the installation.

3. When the installation is complete, click on Finish in dialog box 2 to close 

the dialog box.

Dialog box 1

Dialog box 2Autorun Dialog box
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6.3 Call Center Operation

Menu item Icon button Description
File > Save File (KML) Save the records as the KML format. You can import the KML ýle to Google Earth, 

and it will display the location route. This function only works under the "Search 
Records" mode.

File > Exit Close the Call Center program.

View > GPRS Tracking Switch to GRPS Tracking mode. You can view the information of TR-102 which is 
on line. 

View > Show Map Check this item to show the location point in Google Map or Google Earth.

View > Search Records Switch to Search Records mode. You can inquire information of one user during 
a speciýc time. When you double click on one of these items, it will show the 
location point of this item on Google Map or Google Earth.

Management > User Information Display the User Information. You can setup up to 5 users in the Call Center.

Management > User Edit For deleting a user. The Call Center can only hold 5 users’ information at most. If 
you want to add a new user after you have already set 5 users, please delete a 
existing one ýrst.

Management > Setup When a TR-102 is connected to your PC, you can do the basic setup to this TR-
102.

GPRS > Start Start the Call Center connection to Internet. You can send the commands to TR-

102 if the Call Center is connected online.

GPRS > Pause Pause the Call Center connection from Internet.  While your Call Center is online, 

you can not enter the setup mode unless you pause the connection ýrst. 

GPRS > Send Command to RT102 Send Command to TR-102

Map > Google Map Set to display the location point by "Google Map".

Map > Google Earth Set to display the location point by "Google Earth". 

About Version information. 
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6.4 Basic Setting

1. Connect the USB cable to TR-102 and the PC's USB port after installing the driver.

2. Turn on the power of TR-102: 

(i) Please wait for a while until the startup process is ýnished. 

(ii) Press and hold the "Answer/Hang up" button about 5 seconds until you see the three LEDs 

þashing slowly and simultaneously. Release the button and it will enter the setup mode.

3. Start the TR-102 Call Center program in your PC (or double click on the "TR102-Call Center icon 

from desktop).

4. Click Management > Setup in menu item, then press on the Scan button to scan the COM port 

which TR-102 is connected. (Figure 1) When the scan process is ýnished, click on OK and it will 

automatically set the correct COM Port.

5. Press on the Setup button (Figure 2) to open the setup dialog box.

6. For detailed description of those setting, please refer to the following pages. 

Note:  If your SIM card has the PIN code protected, a 
dialog box will pop up ýrst to ask you to enter the PIN.  

(Be careful when you enter the PIN code. Normally, if you 

enter the wrong code for 3 times, the SIM card will be 

locked. If you do not know the PIN code or it has been 

locked, please consult with your SIM card provider. 

Figure 1

Figure 2
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item option description
Return Type GPRS TR-102 will return the location information by GPRS.

SMS TR-102 will return the location information by SMS.
Answer Mode Off TR-102 will not ring and user can not answer the call. 

When received a call or SMS, TR-102 will return the location information by the way of "Return 
Type".  (please see ýgure. 3 in page 32)

On When received a call, TR-102 will ring, and user can answer the call. (please see ýgure. 1 in 
page 32)
When received a SMS, TR-102 will return the location information by the way of "Return Type". 
(please see ýgure. 2 in page 32)

Return count 1~10 Set the time period in minute for GPS ýxing.
Check Phone 
List

Off TR-102 will return the location information for all the incoming call.
On TR-102 will return the location information only if the number of incoming call is from the Check 

Phone List.
Time Zone On The SMS returned by TR-102 will contain a local time.

Off The SMS returned by TR-102 will contain a Coordinated Universal Time, abbreviated UTC. 
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Note: 
	 The returned SMS from TR-102 to your mobile phone will be the following format: (example)

Position Report:

TR102

2005/01/02 11:20:30

24.9965,121.4877

GPS ýxed

	 Å The second line shows your User Name (default is "TR102").
	 Å The third line contains the date and time. (yyyy/mm/dd hh:mm:ss)
	 Å The fourth line contains the longitude and latitude. You can copy this value and input it to "Google Earth" or maps.google.

com to ýnd this position on map.
	Å The ýfth line indicates "GPS ýxed" or "GPS not ýxed". (If it is "GPS not ýxed", then the information of third and fourth 

lines will be the one from last time GPS ýxed.)

item description
SOS 
Number 
1~3

When SOS button is pressed, TR-
102 will dial to these 3 numbers 
and send the location information 
to them by SMS.  (please see 
ýgure. 4 in page 33)

Quick Dial 
1~3

Assign numbers to Quick Dial 
button 1~3 respectively. (please 
see ýgure. 5 in page 33)
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item description
Phone Number 
1~3

These 3 numbers are same as 
Quick Dial number, you can 
not modify it from here.

Phone Number 
4~10

You can set number 4 ~ 10.

item description

IMEI International Mobile Equipment 
Identity

Firmware 
Version

Firmware version of TR-102

Name Input a user name here. (Default is 
TR102)

Phone Input the phone number of  th is 
TR-102.
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item description

GPRS user name Please consult your 
Call Center system 
administrator for 
all other parameter 
values.

GPRS user password

GPRS apn

GPRS_dns1

GPRS_dns2

item description

GPRS Port Default GPRS Port is 
"5000".

GPRS Server Host 

Name
Set the GPRS server 
host name.



18

 TR-102

19

TR-102   

7. Operating the device

7.1 Turn on / Turn off

7.2 Answer / Hand up the phone

ǒ When there is an incoming call, press this button to answer the 
incoming call. 

ǒ While in talking, press it will hang up the phone.

ǒ Turn on: When the device is off, press the Power button for 3 seconds, 
three LEDs will start to þash quickly from top to bottom. It will enter the 
standby mode with blue LED þash slowly after the startup process is 
ýnished. (During the startup process, it can not be turned off.) Whe the 
device is on, GPS will start to locate its position with the green GPS LED 
þashing. If location is ýxed, the LED will be on for a few seconds and 
then goes out. If the location is not ýxed in 3 minutes, the GPS function 
goes sleep mode for 30 minutes before its next trial. It is suggested that 
you be a outer place where it can receive the better GPS signal when 
you turn on the device.

ǒ Turn off: When the device is on, press the Power button for 3 seconds, 
three LEDs will start to þash slowly from bottom to top. When the LEDs 
go out, it indicates that the device is turned off for sure.  
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7.3 Adjust the volume

ǒ While in talking, you can press the "+" button to increase the volume.
ǒ While in talking, the other party will not hear from you if the mute 

button is pressed to mute the microphone; press it again to enable the 
microphone. 

ǒ While in talking, you can press the "-" button to decrease the volume.

7.4 Making a phone call

ǒ If you have already setup the Quick dial number, then you can press 
the Quick dial button to make a call to the preset number. 
If you want to press the button to make a quick dial , please press the 
button for over 1 second and release.  

Quick dial 1

Quick dial 2

Quick dial 3
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7.5 Send out emergency SMS

ǒ 	If you have already assigned 3 sets of phone numbers to the SOS 
button, press this button on the TR-102 will send out it's location 
information to these 3 sets of phone numbers by SMS. 
To avoid accidentally touching of this button, when you want to send 
out the emergency SMS, please make sure you press this button for 
over 2 seconds and release. 

ǒ 	TR-102 will ýrst call the SOS number 1 and send the location 
information by SMS.  Following, TR-102 will repeat the same 
procedure to SOS number 2 and 3.

i How does it work when you press the SOS button?
1. To conýrm that you have pressed SOS button correctly, TR-102 will followed by long þash the red LED about 2 times.
2. TR-102 will start to position itself with green GPS LED þashing; when the GPS position is ýxed, the LED will be on.  
3. Then, TR-102 will turn off GPS and green LED goes out. 
4. TR-102 begins to send SMS with blue LED þash once per second.
5. When it ýnished sending SMS, the blue LED comes back to standby mode with þash once per three seconds.
6. If the SMS has been sent out successfully, TR-102 will again long þash the red LED about 2 times.
7. If the GPS position can not be ýxed for 3 minutes, it will send back the SMS with a "no ýxed" message and the last ýxed position.
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8. Tracking by SMS mode 
8.1 Setup SMS return type

8.2 Send SMS from a cell phone to TR-102

8.3 TR-102 sends SMS to cell phone

•  Connect the USB cable to TR-102 and 
the PC's USB port. 

•  Enter the setup mode. Select "SMS" 
Return Type from "Phone Mode" tab.

•  Send a short message to TR-102 to trigger it for sending back the location information. (The message 
content can be anything, even a blank message.)

•  When TR-102 receives a short message, it will return the location information by SMS in the following 
format.

Position Report:

TR102

2005/01/02 11:20:30

24.9965,121.4877

GPS ýxed
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8.4 Displaying the location on map
ǒ 	Start the Google Earth software. (For more information about the Google Earth software, please refer to ñTR-102 

Supporting User Manual En_Free Google Earth Software.pdfò which you can ýnd them in the CD-ROM under the 
ñManualò folder.)

Input the latitude and 
longitude that you 
received from SMS and 
click on search button. 

The Google Earth will 
display the location map 
for you. 
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ǒ 	Or you can start the Internet Explorer and type "http://maps.google.com" to connect to Google Map website for displaying 
the location map.  

Select "Satellite" or "Hybrid". It 
depends on Google Map whether your 
area is supported by this mode or not.

Input the latitude and longitude that 
you received from SMS and click on 
Search button. 

The Google Map will display the 
location map for you. 
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9. Tracking by GPRS mode 
9.1 Setup GPRS return type

• Connect the USB cable to TR-102 and the 
PC's USB port. 

• Enter the setup mode. Select "GPRS" 
Return Type from "Phone Mode" tab.

9.2 Trigger the TR-102 to connect to Internet by GPRS
• If the Answer Mode is "Off", you can use the cell phone to call TR-102, or send a short message to TR-

102 to trigger it for connecting to internet.
• If the Answer Mode is "On", you can only send a short message to TR-102 to trigger it for connecting 

to internet.


